Legal Notices

This guide is copyrighted ©2008 by Digidesign, a division of Avid Technology, Inc. (hereafter “Digidesign”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Digidesign.

003, 96 I/O, 96i I/O, 192 Digital I/O, 192 I/O, 888|24 I/O, 882|20 I/O, 1622 I/O, 24-Bit ADAT Bridge I/O, AudioSuite, Avid, Avid DNA, Avid Mojo, Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, Axiom, Beat Detective, Bomb Factory, Bruno, C|24, Command|8, Control|24, D-Command, D-Control, D-Fi, D-fx, D-Show, D-Verb, DAE, Digi 002, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiDrive, DigiRack, DigiTest, DigiTranslator, DINR, D-Show, DV Toolkit, EditPack, Eleven, HD Core, HD Process, Hybrid, Impact, Interplay, LoFi, M-Audio, MachineControl, Maxim, Mbox, MediaComposer, MIDI I/O, MIX, MultiShell, Nitrus, OMF, OMF Interchange, PRE, ProControl, Pro Tools M-Powered, Pro Tools, Pro Tools|HD, Pro Tools LE, QuickPunch, Recti-Fi, Reel Tape, Reso, Reverb One, ReVibe, RTAS, Sibelius, Smack!, SoundReplacer, Sound Designer II, Strike, Structure, SYNC HD, SYNC I/O, Synchronic, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxider, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Transfuser, Trillian Lane Labs, Vari-Fi Velvet, X-Form, and XMON are trademarks or registered trademarks of Digidesign and/or Avid Technology, Inc. Xpand! is Registered in the U.S. Patent and Trademark Office. All other trademarks are the property of their respective owners.

Product features, specifications, system requirements, and availability are subject to change without notice.

Guide Part Number 9329-59291-00 REV A 11/08

Documentation Feedback

At Digidesign, we’re always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@digidesign.com.
Chapter 1. Introduction ........................................................................................................ 1
  MachineControl Version 2.0 ................................................................................................. 1
  MachineControl Components .............................................................................................. 1
  System Requirements and Compatibility ............................................................................... 2
  Digidesign Registration ....................................................................................................... 2
  About This Guide .................................................................................................................. 2
  About www.digidesign.com ................................................................................................ 3

Chapter 2. Installing MachineControl ............................................................................... 5
  Cables and Connections ...................................................................................................... 5
  Connecting Machines .......................................................................................................... 6
  Installing MachineControl Software .................................................................................. 8
  Authorizing MachineControl .............................................................................................. 8
  Uninstalling MachineControl ............................................................................................. 9
  Starting Up Your System ...................................................................................................... 10

Chapter 3. MachineControl Communication Modes ...................................................... 11
  Serial Deck Control Mode .................................................................................................. 11
  Remote 9-Pin Deck Emulation Mode .................................................................................. 12

Chapter 4. Setting Up Machine Control ............................................................................ 13
  Online and Offline Operation .............................................................................................. 13
  Transport Controls ............................................................................................................. 13

Chapter 5. Serial Deck Control Mode (Configuration and Operation) ......................... 17
  Configuring a MachineControl Device for Deck Control .................................................. 18
  Preferences for Serial Deck Control Mode ......................................................................... 20
  Session Setup Window and MachineControl .................................................................... 22
  Additional Pro Tools Commands ........................................................................................ 25
Selecting Pro Tools or the Machine as the Transport Master .................. 26
Playback in Serial Deck Control Mode ........................................... 27
Remote Track Arming ................................................................. 29
Configuring Track Arming ............................................................ 29
Creating a Track Arming Profile .................................................... 30
Arming Tracks Remotely for Layback ............................................. 34

Chapter 6. Remote 9-Pin Deck Emulation Mode (Configuration and Operation) .... 35
 Configuring Remote 9-Pin Deck Emulation Mode ............................... 35
 Preferences for Remote 9-Pin Deck Emulation Mode ......................... 38
 Playback in Remote 9-Pin Deck Emulation Mode .............................. 39
 Recording in Remote 9-Pin Deck Emulation Mode .............................. 39
 Track Arming in Remote 9-Pin Deck Emulation Mode ......................... 40

Chapter 7. Using a Paddle Device in Local Mode ................................ 41
 Connecting a Supported Third-Party Paddle Device to Your Pro Tools System 41
 Allow Track Arm Commands in Local Mode Preference ...................... 42
 Configuring Ports for a Deck and a Supported Third-Party Paddle Device 42

Appendix A. Deck Control Key Commands ....................................... 43

Appendix B. Troubleshooting ......................................................... 45

Appendix C. Machine IDs .............................................................. 47

Appendix D. 9-Pin Cable Pinouts .................................................... 49

Index ......................................................................................... 53
Digidesign® MachineControl™ is special purpose software for Pro Tools HD that enables serial communication with Sony® 9-pin compatible synchronizers, and video or audio machines.

⚠️ Video captured in Pro Tools is intended only for use in Pro Tools. It has not been tested for import into other applications, and may not be of standard broadcast quality. Pro Tools should not be used for laying back picture to video masters.

MachineControl Version 2.0

This guide provides installation and operational instructions for MachineControl version 2.0 for Pro Tools systems on Windows or Mac.

If you require documentation for other system configurations, refer to earlier versions of this guide, available in the Product Support page of the Digidesign website (www.digidesign.com/support).

MachineControl Components

Your MachineControl package includes the following, based on your operating system:

Windows Systems

- MachineControl Installer disc
- Serial Deck Control cable: RS-232 to RS-422
- 9-pin Turnaround adapter (for Remote 9-pin Deck Emulation mode)
- MachineControl iLok License Card

Mac Systems

- MachineControl Installer disc
- Serial Deck Control cable: Male 8-pin mini-DIN to male 9-pin cable
- Remote 9-pin Deck Emulation cable: Male 8-pin mini-DIN to female 9-pin cable
- MachineControl iLok License Card
System Requirements and Compatibility

MachineControl requires the following:

- Digidesign-qualified Pro Tools|HD system, running on a Digidesign-qualified Windows or Mac computer.

Compatibility Information

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.

For a list of Digidesign-qualified computers, operating systems, hard drives, third-party devices, and all the latest compatibility information, visit the Digidesign website (www.digidesign.com/compatibility).

Serial Deck Control Mode Requirements

For Tighter Lockups

- For Serial Deck Control, use of a Digidesign SYNC peripheral is recommended.
- For near sample accurate Serial Deck Control, a SYNC peripheral is required.
- If you are not using a SYNC peripheral with Pro Tools, some features of MachineControl can be used by connecting the deck to the DigiSerial port on a Pro Tools Core card.

Remote 9-Pin Deck Emulation Requirements

A SYNC peripheral is required when running MachineControl 9-Pin Remote Deck Emulation mode, as it provides frame-accurate LTC.

⚠️ Remote 9-Pin Deck Emulation does not work via the serial ports on a SYNC peripheral or via the DigiSerial ports on the Pro Tools HD card. Instead, you must connect the remote controller to your Pro Tools system using one of the following methods:

See “Connecting Machines for Remote 9-Pin Deck Emulation Mode” on page 7.

Digidesign Registration

Review the enclosed Digidesign Registration Information Card and follow the instructions on it to quickly register your purchase online. Registering your purchase is the only way you can be eligible to receive complimentary technical support and future upgrade offers. This is one of the most important steps you can take as a new user.

About This Guide

This guide assumes:

- You have installed Pro Tools and verified that it works properly.
- You have a thorough understanding of your video deck, external 9-pin decks, mixer, and other audio and video equipment.
- You have an understanding of your synchronization equipment and requirements.
Conventions Used in This Guide

This guide uses the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 **User Tips** are helpful hints for getting the most from your system.

⚠️ **Important Notices** include information that could affect your data or the performance of your system.

🔍 **Cross References** point to related sections in this guide and other Digidesign guides.

About www.digidesign.com

The Digidesign website (www.digidesign.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

**Product Registration** Register your purchase online. See the enclosed Digidesign Registration Information Card for instructions.

**Support and Downloads** Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; or join the worldwide Pro Tools community on the Digidesign User Conference.

**Training and Education** Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

**Products and Developers** Learn about Digidesign products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Digidesign or sign up for a Pro Tools demo.

**Pro Tools Accelerated Videos** Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins.
Before you Begin

Before you install MachineControl, make sure that you have already connected and verified operation of your Pro Tools system.

If you are using a Digidesign SYNC peripheral, refer to its guide to make sure your equipment is installed and operating correctly.

Cables and Connections

MachineControl requires its own connections between Pro Tools hardware, the computer, and external machines. Connections differ depending on your Pro Tools audio interface, operating system, and on which of the two MachineControl operational modes you want to use: Serial Deck Control mode or Remote 9-Pin Deck Emulation mode.

💡 When using a supported third-party paddle device with Pro Tools, you can use both Serial Deck Control mode and Remote 9-Pin Deck Emulation mode simultaneously. See Chapter 7, “Using a Paddle Device in Local Mode” for more information.

Cables

MachineControl comes with the following cables and adapters, depending on your computer platform:

Windows Systems

Serial Deck Control Cable RS-232 to RS-422 cable, for serial time code and all other MachineControl functions.

Turnaround Adapter 9-pin adapter, used with RS-232 to RS-422 cable, for Remote 9-Pin Deck Emulation.

Mac Systems

Serial Deck Control Cable Male 8-pin mini-DIN to male 9-pin cable, for Deck Control.

Remote Deck Emulation Mode Cable Male 8-pin mini-DIN to female 9-pin cable, required for Remote 9-Pin Deck Emulation.

⚠️ Do not substitute 9-pin or serial adaptors for either MachineControl cable. Each cable is specifically wired for one operation mode.
Serial Deck Control Mode

Serial Deck Control mode supports bi-directional communication between Pro Tools and a compatible external machine. With this feature you can:

- Synchronize to serial time code
- Arm tracks on the machine remotely
- Control a transport from Pro Tools
- Configure machine settings and options.

Pro Tools|HD Systems

With Pro Tools|HD systems, you can use a Serial to 9-pin connection or a 9-pin to 9-pin connection for Serial Deck Control mode.

CPU to Deck Connection

This type of connection yields the best performance, especially with linear decks. Use the included Serial Deck Control cable for this type of connection.

SYNC Peripheral to Deck Connection

This type of connection is suitable for non-linear decks. If you are using a SYNC peripheral, as many as two machines can be connected to the two 9-pin Out ports on the SYNC peripheral. You can control one machine at a time, and switch between them from within Pro Tools. These ports support all MachineControl modes except Remote 9-Pin Deck Emulation mode. For Remote Deck Emulation mode on Mac systems, a Keyspan USA28x serial adapter connected to a computer USB port, and a properly wired configuration. See Chapter 6, “Remote 9-Pin Deck Emulation Mode (Configuration and Operation)” for details.

Connecting Machines

This section describes how to connect machines for Serial Control Mode or Remote 9-Pin Deck Emulation Mode.

Connecting Machines for Serial Control Mode

For Best Serial Deck Control

For best serial deck control, connect your deck as follows:

To connect a deck to a Windows computer:
- Connect the computer’s COM port to the machine, using the provided 9-pin RS-322 to RS-422 cable.
To connect a deck to a Mac computer:

1. Connect a Keyspan USA28x USB serial adapter (not provided) to a USB port on the computer.
2. Connect the provided male mini DIN-8 serial to male 9-pin D-sub Deck Control cable to the end of the adapter.
3. Connect the end of the cable to the machine.

For Limited Serial Deck Control (Non-Linear Decks Only)

- Connect a standard 9-pin cable from one of the 9-pin Out ports on the SYNC peripheral to the 9-pin input of the machine. Due to performance limitations, this configuration should be used primarily with non-linear decks.

Connecting Machines for Remote 9-Pin Deck Emulation Mode

To connect a machine for Remote 9-Pin Deck Emulation mode (Windows Systems):

- Connect the Turnaround adapter to the RS-322 to RS-422 cable, and connect them from an available serial or COM port on your computer to the 9-pin output of the machine.

Do not use the DigiSerial port on your HD Core card or the 9-pin ports on the SYNC peripheral for Remote 9-Pin Deck Emulation mode. The DigiSerial port should only be used for SYNC peripheral connections, using a DigiSerial cable.

To connect a machine for Remote 9-Pin Deck Emulation mode (Mac Systems):

1. Connect a Keyspan USA28x USB serial adapter (not provided) to a USB port on the computer.
2. Connect the provided male mini DIN-8 serial to female 9-pin Deck Emulation cable to the end of the adapter.
3. Connect the end of the cable to the machine.

Do not use the DigiSerial port on your HD Core card or the 9-pin ports on the SYNC peripheral for Remote 9-Pin Deck Emulation mode. The DigiSerial port should only be used for SYNC peripheral connections, using a DigiSerial cable.

Using a Rosetta Stone Adapter with MachineControl

(Windows XP Only)

Using the Rosetta Stone adapter with MachineControl on Windows XP lets you do either of the following:

- Use a Tamura synchronizer with Remote mode
- or –
  - Increase reliability for long cable runs for Serial Deck Control mode or Remote mode

A Rosetta Stone RS-232 to RS-422 adapter (model 2/8 or 2/9) and additional RS-232 and RS-422 cables are required.

To set up a Rosetta Stone convertor for a Tamura synchronizer in Remote mode:

1. Connect the RS-232 cable from your computer’s COM port to the RS-232 side of the Rosetta Stone adapter.
2. Connect the RS-422 cable from the RS-422 side of the Rosetta Stone to the Digidesign Remote Mode adapter (included with MachineControl purchase).
3. Connect the Digidesign Remote Mode adapter to your synchronizer or 9-pin patch bay. Add more 9-pin cable on the 422 end if a longer run is needed.
To increase reliability in long cable runs in Remote mode:

- Follow the instructions as described above for setting up a Rosetta Stone convertor for a Tamura

To increase reliability in long cable runs in Serial Deck Control mode:

1. Connect the RS-232 cable from your computer’s COM port into the RS-232 side of the Rosetta Stone adapter.

2. Connect the RS-422 cable from the RS-422 side of the Rosetta Stone to the deck or 9-pin patch bay. If a longer run is needed, add more 9-pin cable on the RS-422 end.

**Installing MachineControl Software**

To install MachineControl, you can use the Pro Tools Installer disc, or the MachineControl Installer disc.

**To install MachineControl software:**

1. Insert the Installer disc into your computer.

2. Locate and and double-click the MachineControl installer application.

3. Follow the on-screen instructions to complete installation.

4. When installation is complete, click Finish (Windows) or Close (Mac).

**Authorizing MachineControl**

MachineControl is authorized using the iLok USB Smart Key (iLok), manufactured by PACE Anti-Piracy, Inc.

![iLok USB Smart Key](image)

The iLok is similar to a dongle, but unlike a dongle, it is designed to securely authorize multiple software applications from a variety of software developers.

This key can hold over 100 licenses for all of your iLok-enabled software. Once an iLok is authorized for a given piece of software, you can use the iLok to authorize that software on any computer.

⚠️ *The iLok USB Smart Key is not supplied with your plug-in or software option. You can use the one included with your Pro Tools|HD system, or purchase one separately.*
To authorize MachineControl:

1. If you do not have an iLok.com account, visit www.iLok.com and sign up for an iLok.com account.

2. Transfer the license for MachineControl to your iLok.com account by doing the following:
   - Enter your Activation Code (listed on your Activation Card) and your iLok.com User ID. Your iLok.com User ID is the name you create for your iLok.com account.

3. Transfer the licenses from your iLok.com account to your iLok USB Smart Key by doing the following:
   - Insert the iLok into an available USB port on your computer.
   - Go to www.iLok.com and log in.
   - Follow the on-screen instructions for transferring your licences to your iLok.

4. Launch Pro Tools.

5. If you have any installed unauthorized plug-ins or other software options, you will be prompted to authorize them. Follow the on-screen instructions to complete the authorization process.

Uninstalling MachineControl

If you need to uninstall the MachineControl option from your system, follow the instructions below for your computer platform.

Mac OS X

To uninstall an option:

1. Open the Pro Tools folder on your Startup drive (Applications/Digidesign).
2. Drag the option to the Trash and empty the Trash.

Windows XP

To uninstall an option:

1. Choose Start > Control Panel.
2. Double-click Add or Remove Programs.
3. Select the option from the list of installed applications.
4. Click Remove.
5. Follow the on-screen instructions to remove the option.

Windows Vista

To uninstall an option:

1. Choose Control Panel.
2. Under Programs, click Uninstall a Program.
3. Select the option from the list of installed applications.
4. Click Uninstall.
5. Follow the on-screen instructions to remove the option.
Starting Up Your System

To ensure that the components of your Pro Tools system communicate properly with each other and your external machines, start them in a particular order.

Start up your Pro Tools system in this order:

1. For systems with an expansion chassis, turn on the chassis.

2. Turn on any external hard drives. Wait approximately ten seconds for them to come up to speed.

3. Turn on any external machines (VTR, ATR, synchronizer, and monitors).

4. Turn on any MIDI interfaces, MIDI devices and synchronization peripherals.

5. Lower the volume of all output devices in your system.

6. Turn on Pro Tools audio interfaces. Wait at least fifteen seconds for your system hardware to initialize.

7. Turn on your computer.

8. Launch Pro Tools.

Machine Local and Remote Modes

Be sure to set your machine-controllable device to “remote” or “ext” mode to receive the 9-pin information (not “local” or front-panel mode). With some supported machines, if all other communication is established and the machine is not in remote mode, Pro Tools will indicate machine “local” mode.
MachineControl supports two machine communication modes: *Serial Deck Control mode* and *Remote 9-Pin Deck Emulation mode*.

### Serial Deck Control Mode

With *Serial Deck Control mode*, you can use the Pro Tools Transport window to control an external deck.

#### Transport

The setting of the Transport Master (located in the Pro Tools Transport window) determines the type of Serial Deck Control, as follows:

**Transport = Pro Tools** The Transport window controls the Pro Tools Timeline. When online, the deck locates relative to actions taken in the Pro Tools Timeline.

**Transport = Machine** The Transport window controls the machine. When Pro Tools is Online, the Pro Tools Timeline chases the machine.

#### Cueing and Pre-Roll

Pro Tools Preference settings let you optimize MachineControl operation, including adjustable machine pre-roll, selectable edit and memory location chasing.

#### Track Arming

When the Transport Master is set to Transport = Machine, you can arm tracks of external machines from within Pro Tools for layback and transfer. Features include individual record enables for up to 48 external tracks, with selectable record protocol and mode. Machine profiles included with the software let you preconfigure track arming for many machine types.

#### Serial Time Code

When the Positional Reference is set to Serial Time Code in the Session Setup window, Pro Tools can control an external machine via the Serial Deck Control cable. This setting also enables Pro Tools to receive time code directly using only the Serial Deck Control cable.

(This mode requires that the 9-pin device be capable of transmitting serial time code. It also requires that the Pro Tools and the device receive a common video reference.)
Using a Paddle Device in Local Mode

When using MachineControl in Local mode with or without an external synchronizer, you can use a supported third-party paddle device to issue the following Pro Tools track commands:

- Input monitoring
- Record Enable
- Record Safe
- Solo
- Solo Mute

See Chapter 7, “Using a Paddle Device in Local Mode.”

Remote 9-Pin Deck Emulation Mode

With Remote 9-Pin Deck Emulation mode (also called Remote 9-Pin mode), an external synchronizer can take control over Pro Tools transport and recording functions.

Pro Tools responds to commands sent by the master 9-pin machine controller, but because Pro Tools is in Remote mode, many of its transport commands are locked out.

Remote and Remote/LTC Chase Modes

When using an external machine controller to control Pro Tools, you can configure Pro Tools to emulate a 9-pin deck in either of the following modes:

Remote mode Pro Tools emulates a device that can be the time code master or time code slave.

Remote/LTC Chase mode Pro Tools emulates a device that receives track and transport arming commands, while chasing incoming LTC.

Track Arming

In Remote Deck Emulation mode, you can arm Pro Tools tracks from an external machine.

Features include remote control of individual record enables for up to 48 tracks, with selectable record protocol and mode. Included factory and user programmable profiles let you configure track arming for any machine type.

For arming tracks during playback, refer to the TrackPunch feature description in the Pro Tools Reference Guide.
Chapter 4: Setting Up Machine Control

Online and Offline Operation

Pro Tools can remotely control, or be controlled by, any approved enabled external device. You can select a device by using the Transport Master selector in the Transport window.

To trigger Pro Tools playback or recording from an external source, or to generate time code, the Pro Tools Transport needs to be *online*. There are four ways to put the Pro Tools Transport online:

- Click the Online button in the Transport window.
- Choose Options > Transport Online.
- Press Control+J (Windows) or Command+J (Mac).
- Press Alt+Spacebar (Windows) or Option+Spacebar (Mac).

The Online button in the Transport window indicates online status. It flashes while enabled and waiting for synchronization, and stays lit when lock is achieved.

Transport Controls

With MachineControl, the Pro Tools Transport window becomes a multi-function controller.

Counter Display

The Pro Tools Edit window counter displays the current machine (9-pin) or session time code location, depending on which device is the Transport Master, plus any current Session Start Time Offsets being applied. (See “External Time Code Offsets” on page 24 for more information.)

The Incoming Time display in the Session Setup window always shows absolute incoming time code, without any offsets.
Selecting a Transport Master

To select a Transport Master:

1. Click the Transport Master selector to display the Transport pop-up menu.

In this mode, the controls in the Transport window are focused on Pro Tools playback and recording.

- When the transport is online, the machine slaves to Pro Tools, and the session locks to the machine’s time code. The machine follows Preferences for Machine Chase and Online Record.
- When the transport is offline, the Pro Tools Transport window controls Pro Tools only.

Selecting the Transport Master

2. From the Transport pop-up menu, select Pro Tools, Machine, or Remote (or Remote/LTC).

➤ You can also press Control+backslash (\) to toggle between Pro Tools, the Machine, and Remote transport (or, on a Digidesign control surface, press EXT TRANS).

Transport = Pro Tools

In this mode, the controls in the Transport window are focused on Pro Tools playback and recording.

- When the transport is online, the machine slaves to Pro Tools, and the session locks to the machine’s time code. The machine follows Preferences for Machine Chase and Online Record.
- When the transport is offline, the Pro Tools Transport window controls Pro Tools only.

Transport = Machine

In this mode, the controls in the Transport window are focused on the machine connected and enabled for Serial Deck Control mode. Record commands are sent to the machine only.

- When the transport is online, Pro Tools slaves to the machine. The Transport window controls the machine, and Pro Tools chases and locks to it.

In addition, when Auto Spot is turned on, regions are spotted to the current machine time, and the Trimmer tool trims to the current machine time.

➤ See the Pro Tools Reference Guide for details on Auto Spotting.

- When the transport is offline, the Pro Tools Transport window controls the machine only.

Toggling the Transport while Online

When the Transport window is online, toggling the Transport Master selector between Pro Tools and your machine will also toggle their master/slave relationship.
**Toggling the Online Status of a Device**

Use the Online pop-up menu in the Transport Master selector to toggle the online status of a Machine (or MMC) device.

**To take a device offline:**

1. Click the Transport Master selector.
2. Click on the Online pop-up menu and select or deselect the device (Machine or MMC) by clicking on it. Device choices depend on the current Transport Master and which devices have been set up in Pro Tools.

![Transport pop-up menu](image.png)

*Transport pop-up menu in Transport window*

> The Online pop-up menu will only display devices that have been properly set up in Pro Tools.

To set up machine devices, see Chapter 5, “Serial Deck Control Mode (Configuration and Operation).”

To set up MIDI devices, see the Pro Tools Reference Guide.

**Online Display Information**

Several display elements of the Edit and Transport windows provide machine status information during MachineControl use, as follows:

- When Pro Tools is online, the Transport Online button flashes. “Waiting for Sync” will be displayed in the status box in the lower left corner of the Edit window.
- The Transport Online button continues to flash until you click Play and time code lock occurs (all devices locked and responding in sync).
- The Time Code display in the Edit window shows the Machine Time when the machine is Master.
- Upon lockup, the Time Code display switches to show the session time.
Remote Mode

In Remote 9-Pin Deck Emulation mode, you put Pro Tools in Remote mode to enable Machine Control operation.

- When you put Pro Tools in Remote mode, it responds to commands sent by the master 9-Pin machine. Many Pro Tools commands, including transport controls, are inactive in the Transport window.

- When you take Pro Tools out of Remote mode, it operates in Local mode and ignores commands from the 9-pin machine controller. Pro Tools responds only to requests from the 9-pin machine controller for machine type and status, and returns that it is in Local mode.

To put Pro Tools in Remote mode:

1. Choose View > Transport > Synchronization.

2. Click the Remote button in the Transport window.

For more information on Remote mode in Pro Tools, see Chapter 6, “Remote 9-Pin Deck Emulation Mode (Configuration and Operation).”
Serial Deck Control mode is available whenever MachineControl is connected using the Serial Deck Control cable. For more information about connecting Pro Tools for Serial Deck Control mode, see Chapter 2, “Installing MachineControl.”

When connected for Serial Deck Control mode, MachineControl enables all Pro Tools track arming, synchronization, and Transport features, as available on your system. Serial Deck Control mode also supports 9-pin serial time code (see “Using Serial Time Code for Positional Reference” on page 19). Some features require a SYNC peripheral, as noted throughout this chapter.

For information on track arming, see “Remote Track Arming” on page 29.

Configuring Pro Tools for Serial Deck Control (Overview)

To configure Pro Tools for Serial Deck Control, do the following:

1. Open an existing session or create a new session.
2. Set up a MachineControl device. (See “Configuring a MachineControl Device for Deck Control” on page 18.)
3. Configure Pro Tools Machine Control preferences and Online Options in the Preferences dialog. (See “Preferences for Serial Deck Control Mode” on page 20.)
4. Configure Pro Tools session settings in the Session Setup window. (See “Session Setup Window and MachineControl” on page 22.)
5. In the Pro Tools Transport window, select Pro Tools or Machine as the Transport Master. (See “Selecting Pro Tools or the Machine as the Transport Master” on page 26.)
6. Use the Transport window to play back material. (See “Playback in Serial Deck Control Mode” on page 27.)
Configuring a MachineControl Device for Deck Control

To set up a MachineControl device:

1. In Pro Tools, choose Setup > Peripherals, and click the Synchronization tab.

2. Configure your synchronization peripheral as necessary. If you are using a Digidesign SYNC peripheral, select Enable SYNC Peripheral.

3. Click the Machine Control tab in the Peripherals dialog.

4. In the 9-pin Machine Control (Deck Control) section, select Enable.

5. Select the 9-pin MachineControl port from the Port pop-up menu.

6. Choose the appropriate machine profile from the Machine Type pop-up menu.

7. Set machine pre-roll for use when Transport = Pro Tools. (See “Machine Pre-Roll” on page 18 for more information.)

Machine pre-roll is different from the main Transport pre-roll that is set in the Transport window.

If you are using a Digidesign SYNC peripheral connected to your DigiSerial port, and your machine has time code reader capability, you can use serial time code for Positional Reference.

8. Click OK to close the Peripherals dialog.

Machine Pre-Roll

You can set a variable amount of machine pre-roll to account for the time it may take the machine to achieve servo lock. Shorter pre-roll values are usually better for non-linear machines. Longer pre-roll values are usually better for older tape transports.

The Machine pre-roll value is added to any pre-roll specified in the Pro Tools Transport window.

To set MachineControl pre-roll:

1. In Pro Tools, choose Setup > Peripherals, and click the Machine Control tab.

2. In the 9-pin Machine Control (Deck Control) section, type the number of frames of pre-roll in the Preroll box.

3. Click OK.

Do not use the designated machine serial port for any other function (such as time code or MIDI metronome). Make sure that 9-pin is the only communication on the selected port.

Pro Tools lets you define and save custom machine profiles. See “Remote Track Arming” on page 29 for more information.
Selecting Machines in Serial Deck Control Mode

When using a Digidesign SYNC peripheral with machines connected to each of its two 9-pin ports, or to serial ports on the computer, use the Peripherals dialog to choose which machine to control.

To choose a machine for Serial Deck Control mode:

1. In Pro Tools, choose Setup > Peripherals, and click the Machine Control tab.
2. In the 9-pin Machine Control (Deck Control) section, select Enable.
3. Choose SYNC 9-Pin Out 1 or SYNC 9-Pin Out 2, or an available serial port from the Port pop-up menu.
4. Choose the appropriate machine profile from the Machine Type pop-up menu.
5. Click OK to close the Peripherals dialog.

Using Serial Time Code for Positional Reference

If you are using a Digidesign SYNC peripheral connected to your DigiSerial port, and your machine has 9-pin serial time code capability, you can use serial time code for positional reference. This will help achieve faster lockup times.

To use serial time code for positional reference, a Video Reference signal must be present, as indicated by the Ref Present indicator in the Session Setup window. Both the SYNC peripheral and the external machine should be locked to the same video reference signal.

When using Serial Time Code for positional reference, you can regenerate LTC.

To enable Serial Time Code:

1. Choose Setup > Session.
2. Choose Serial Time Code from the Positional Reference pop-up menu.

To regenerate LTC when locking to Serial Time Code:

1. Choose Setup > Session.
2. Choose Serial Time Code from the Positional Reference pop-up menu.
3. In the Transport window, click the Gen LTC button.
Preferences for Serial Deck Control Mode

You can configure preferences for MachineControl playback and recording in Pro Tools.

Playback Options

Machine Control Section

Machine Chases Memory Location When selected, navigating to a specific location in a session with a Memory Location causes a connected transport to chase to that location.

Machine Follows Edit Insertion/Scrub When selected, navigating to a specific location in a session by moving the selection point or by scrubbing a track will cause a connected transport to chase to that location.

机器 When the connected device is a linear device (such as a tape deck), select Linear Devices (jog) to set Pro Tools to send jog commands.

Non-line When the connected device is a non-linear device (such as a random-access video recorder or another Pro Tools system), select Non-Linear Devices (cue) to set Pro Tools to send cue commands.

Machine Cues Intelligently When selected, if you navigate to a cue point that is more than 10 seconds from the current location, Pro Tools will command a connected transport to fast wind to the new location at full speed to within 10 seconds of the cue point. Cueing will then slow to normal speed until the point is reached. This can significantly speed up tape cueing with certain video transports.

Stop at Shuttle Speed Zero Causes Pro Tools to send a Stop command whenever you stop shuttling. This is useful if you have a machine that requires an explicit stop command to park correctly.

Non-Linear Transport Error Suppression When Transport = Pro Tools, keeps Pro Tools from sending a Stop command when taken offline. This prevents Pro Tools from stopping any other 9-pin devices connected to the system.

Synchronization Section

Minimum Sync Delay Sets the amount of time (in frames) for devices to achieve synchronization “lock.” This amount varies for each device. Pro Tools lock up delay is set by entering a value for Minimum Sync Delay in the Synchronization page of the Preferences dialog. The lowest value available is 15 frames. Find the shortest possible lock-up time that your equipment can operate at consistently, and set this as the delay value.

Delay Before Locking to Longitudinal Time Code Sets the amount of time (in frames) for Pro Tools to lock to incoming LTC. Use this option when locking Pro Tools to a stable time code source (such as a non-linear machine or LTC generator) and not a linear tape machine.

Delay Before Locking to Serial Time Code Sets the amount of time (in frames) for Pro Tools to wait before attempting to lock to machines that issue servo lock messages. This setting allows time for the servo mechanisms to achieve stable lock.

To set Machine Control playback options:

1. Choose Setup > Preferences, and click the Synchronization tab.
2. Select or set Machine Control options.
3. Click OK to close the Preferences dialog.
**Recording Options**

**Record Online at Time Code (or ADAT)**  
**Lock** When selected, online recording begins as soon as Pro Tools receives and locks to incoming time code.

**Record Online at Insertion/Selection** When selected, online recording begins at the edit cursor location. Recording continues until Pro Tools stops receiving time code. If you make a selection, Pro Tools records online for the length of the selection.

To set Serial Deck Control mode recording options:

1. Choose Setup > Preferences, and click the Operation tab.

2. Select or set the above Online options in the Record section.

3. Click OK to close the Preferences dialog.
Session Setup Window and MachineControl

The Session Setup window has three sections.

**Format** Displays session sample rate, bit depth, audio format, and incoming time code values. Lets you set Clock Source, Session Start Time, Time Code Rate, Feet+Frames Rate, and choose a secondary time code ruler.

**SYNC Setup & Time Code Offsets** Lets you set Clock Reference and Positional Reference, Video Reference format, and Video Input format.

**Time Code Settings** Lets you configure Time Code Freewheel settings and Audio and Video Pull Up/Down amounts.

To show **SYNC Setup and Time Code Offsets**:
- Click the SYNC Setup and Time Code Offsets show/hide button.

To show **Time Code Settings**:
- Click the Time Code Settings show/hide button.
Session Settings for MachineControl

Use the steps in this section to quickly configure the basic session settings for MachineControl.

Basic Session Settings

Confirm the following settings for each session.

To configure a session for MachineControl:

1. Open an existing session or create a new one.
2. Choose Setup > Session.
3. In the Format section, do the following:
   - Set a Session start time.
   - Set the session Timecode Rate and Feet+Frames Rate.

To configure Clock Source and Reference settings:

1. Choose Setup > Session.
2. In the Format section, select a Clock Source (a SYNC peripheral or a Pro Tools|HD audio interface) from the Clock Source pop-up menu.
3. In the SYNC Setup section, select a Clock Reference and Positional Reference.
4. In the SYNC Setup section, set the appropriate Video Reference and Video In formats.

See the SYNC HD Guide for more information on setting Clock Reference, Positional Reference, Video Reference, and Video In formats.
**Testing Session Settings**

To check your session and MachineControl settings, place the machine in Local mode and manually start playback on the external machine. If Pro Tools is receiving time code, the current location will be shown in the Incoming Time display. Be sure to reset the machine to Remote mode when finished.

![Incoming Time display](image)

**External Time Code Offsets**

In the External Time Code Offsets section, Pro Tools lets you compensate for devices that are consistently offset by a fixed number of frames (such as some color–corrected video masters), or for material that starts at a different time than the session.

Pro Tools provides four different External Time Code Offset settings:

- MMC (MIDI Machine Control)
- 9-Pin (Deck Control)
- Synchronization peripherals such as the SYNC HD, SYNC I/O, or other peripherals (such as MIDI interfaces that provide MIDI Time Code).
- Satellite (Pro Tools with Satellite Link or Video Satellite)

Unique values can be defined for each of these types of offsets, or you can link all to adjust in unison.

Positive and negative offset values can be entered to offset Pro Tools time code display later or earlier, respectively.

---

**Sample Offset**

This field lets you set an offset value for incoming time code (up to the equivalent of plus or minus one frame at the current session sample rate). This lets you create a permanent offset to fine-tune the point at which Pro Tools synchronizes relative to incoming time code. For example, a value of –50 makes an event in Pro Tools occur 50 samples before the same event in the incoming time code. Use this to compensate for timing differences between various SMPTE-to-MIDI Time Code converters or analog-to-digital/digital-to-analog converters.

**Offsets and SYNC Time Code Display**

The time code display on the front panel of the SYNC peripheral continues to display actual incoming time code, regardless of any External Time Code Offset applied in Pro Tools.

**To apply an offset to an external time code source:**

- In the Session Setup window, enter an offset value time in an offset field.

**To apply the same time code offset to all devices:**

- In the Session Setup window, select Link to apply the same offset value to all devices.
Time Code Settings

The Time Code settings control time code generation, Freewheel, and session Pull Up and Pull Down options.

Configure these settings as appropriate for the current project and situation. (For complete instructions, refer to the Pro Tools Reference Guide and the SYNC HD Guide.)

Additional Pro Tools Commands

The following commands are available in all MachineControl operating modes.

Current Time Code Position

Use this command to redefine the current time code position and session start time. By creating an insertion point (or selection), and then entering the desired new time code position for that location, the session start time will be recalculated based on the new, relative Time Code location.

For example, if you place an insertion point at 01:02:04:11, choose Setup > Current Time Code Position, and enter 01:00:08:00 to correspond to the first frame of film, this adjusts the session start time such that the insertion point location is now 01:00:08:00.

To redefine the current time code location:

1. Enable Link Edit/Timeline.
2. Click the Grid mode selector. This ensures that your selection is on a frame boundary.
3. Locate Pro Tools to the beginning of the relevant material (usually the first audio of a scene, a 2 pop, or similar).
4. If appropriate, cue the external time code source to the location where you want to align the current Pro Tools insertion point. Note the time code location, or copy it to the clipboard.
6. Type the new time code position in the Desired Time Code Position text box.
7. Click OK.

Current Feet+Frames Position

Use this command to redefine the Feet+Frames position at the current insertion point (or starting point of the selection).

Redefining Feet+Frames does not redefine the session start time.

Typically, this command is used for integrating test tones, pre-roll, and similar pre-program material into the Pro Tools session ahead of the first hour time code position on the Timeline. In most cases when working on reels of film, the user will want to set the first hour mark in the session to equal 0+0 feet and frames, to line up properly with the start of the Academy leader for each reel of film.

To set a relative frame position for a session (Feet+Frames):

1. Enable Link Edit/Timeline.
2. Click the Grid mode selector. This ensures that your selection is on a frame boundary.
3. With the Selector tool, click in a track (or make a selection) where you want to redefine the position.
5. Enter a Feet+Frame position in the Desired Feet+Frames Position text box.
6. Click OK.
Create Machine Track Arming Profile

The Create Machine Track Arming Profile command lets you create and save machine descriptions as Machine Profiles. Profiles are provided for an ever-increasing list of common machines, or you can customize profiles for specific situations and requirements. Options include the ability to emulate a different machine type, remap and rename audio tracks, and choose to include or exclude the video and time code tracks, when available. For more information, see “Creating a Track Arming Profile” on page 30.

Selecting Pro Tools or the Machine as the Transport Master

In Serial Deck Control mode, the deck is always the time code master. However, the start of machine playback changes based on the Transport Master mode you are using.

The setting of the Transport Master (located in the Pro Tools Transport window) determines where the deck will start playback when the Pro Tools Transport sends a play command to the deck Control, as follows:

Transport = Pro Tools

In this mode, the Transport window controls the Pro Tools Timeline position (playback and recording). When you click Play in the Transport window while it is online, the deck locates relative to the current Pro Tools Timeline.

- When the Transport window is online, the machine locates to a position ahead of the current Timeline insertion point. This location ahead is equal to the sum of the machine pre-roll and the Transport pre-roll. Once the machine has located to this total pre-roll position, it plays, sending time code to Pro Tools, which chases that incoming time code. The machine follows the Preferences settings for Serial Deck Control. (See “Preferences for Serial Deck Control Mode” on page 20.)
- When the Transport window is offline, the Pro Tools Transport window controls Pro Tools only.

Transport = Machine

In this mode, the Transport window controls the machine connected and enabled for Serial Deck Control mode. Record commands are sent to the machine only. When online and a Play command is given, the machine plays from its current location, feeding time code to Pro Tools, which chases that incoming time code from the deck.

- When the Transport window is online, Pro Tools chases the time code coming from the machine. The Transport window controls the machine, and Pro Tools chases and locks to it.
- All record commands in this mode are directed to the deck only.
- When Auto Spot is turned on, regions are spotted to the current machine time, and the Trimmer tool trims to the current machine time.

- For details on Auto Spotting, see the Pro Tools Reference Guide

- When the Transport is offline, the Pro Tools Transport window controls the machine only.
To select a Transport Master:

1. In Pro Tools, click the Transport Master selector to display the Transport Master pop-up menu.

2. From the Transport Master pop-up menu, select Pro Tools or Machine.

Toggling the Transport while Online

When the Online button is highlighted, toggling the Transport Master between Pro Tools and Machine also toggles their master/slave relationship.

Press Control+backslash (\) (Windows) or Command+backslash (\) (Mac) to toggle between available Transport Master choices.

Playback in Serial Deck Control Mode

To play or cue your machine independently of Pro Tools:


2. Make sure Pro Tools is not online (the Online button in the Transport window is not flashing).

3. Click any of the buttons in the Pro Tools Transport window to control your machine.

Pro Tools always displays incoming LTC or 9-pin time in the incoming time field in the Session Setup window during fast-wind, and switches during playback to display the current positional reference.

To automatically locate your deck to pre-roll into your current Timeline insertion time each time you play back:


2. Put Pro Tools online.

3. Click Play in the Transport window.

If the tape in the machine is striped with time code that matches your Session time, the machine will locate to the total pre-roll position ahead of the Pro Tools on-screen selection/insertion point or memory location, and begin playing back. Pro Tools will chase its time code output.

Machine Remote Setting

If the Transport Master selector will not stay set to Machine, or if it switches to Pro Tools from Machine, check your machine’s Local/Remote setting. It should be set to Remote to receive commands from the Pro Tools Transport.
Machine Cueing

MachineControl provides two Cue modes for remote machine operation: Search and Hi-speed.

- In Search mode, the tape remains laced during Fast Forward or Rewind.
- In Hi-speed mode, the tape is unlaced before fast-forward/rewind. The Transport window indicates the status of the tape as described below.

Search Mode

In Search mode, the tape is laced against the heads when the machine is paused or searching, and the Stop button stays lit (it does not flash) and the Play button flashes. When cueing in this mode, the Fast Forward or Rewind button also lights when searching in either direction.

To fast forward and rewind in Search mode:

2. Click Play in the Transport window or press the Spacebar to begin machine playback, then press the Spacebar again to pause the machine (this is to ensure that the tape is laced).
3. Click Fast Forward or Rewind in the Transport window to search the tape.

⚠ Some devices, including several popular VHS decks, do not support a shuttle mode in which the tape stays laced. These decks unlace the tape before shuttling. Refer to your tape machine’s guide for more information.

Hi-Speed Mode

In Hi-speed mode, the tape is unlaced, and all Transport window buttons are dark. When you cue in this mode, only the selected Fast Forward or Rewind button lights.

To fast forward and rewind in Hi-speed mode:

2. To unlace the tape, click Stop in the Transport window or press Command+period(.)
3. Click Fast Forward or Rewind in the Transport window. The Pro Tools cursor indicates the current machine location.
4. Press the Spacebar to pause the machine.

⚠ Some devices may not support all shuttle modes, and may not accept the above shuttle commands. In these cases, the Fast Forward and Rewind buttons in the Pro Tools Transport window flash, and clicking them places the device in true Fast Forward / Rewind mode.

Spotting to the Machine

To spot regions to the machine’s current location, use Pro Tools Spot mode and/or Auto Spot (if using VITC).

See the Pro Tools Reference Guide for information on using Spot and Auto Spot mode to spot regions to incoming SMPTE time code locations.

⚠ Auto Spot mode uses incoming VITC for location information. Therefore, Auto Spot mode will force the Region to be spotted to the current incoming machine time code location, not the current insertion cursor location. To spot your elements directly to the current cursor location, Control-drag (Mac) or Right-click and drag (Windows) the elements.
Remote Track Arming

Pro Tools with MachineControl provides the ability to record-arm audio, video, or time code tracks on external decks, and rehearse an edit.

On MachineControl-equipped systems, the Machine Track Arming command is available in the Pro Tools Window menu. The Machine Track Arming window lets you configure track arming during sessions using the settings appropriate for the current Track Arming Profile. (See “Identifying Your Machine” on page 29.)

To display the Machine Track Arming window:

- Choose Window > Machine Track Arming.

You can also define, save, and load customized device profiles. (See “Creating a Track Arming Profile” on page 30.)

Not all machines support independent arming of their audio tracks locally or remotely, and some machines require a separate utility menu selection. Pro Tools remote track arming cannot operate in these situations.

Identifying Your Machine

When you configure Pro Tools for MachineControl, it automatically loads the track arming profile for the identified machines.

For more information on basic Pro Tools settings for MachineControl, see “Configuring a MachineControl Device for Deck Control” on page 18.

If Pro Tools does not recognize your machine, or if you want your machine to emulate a different type of device (for example, to use a different track layout), you can load a generic machine profile.

If you are using a generic machine profile, be sure to double-check record behavior using non-essential tapes before using MachineControl’s remote track arming functions.

For maximum flexibility, use Track Arming Profiles to create, customize, and manage multiple machine descriptions (see “Creating a Track Arming Profile” on page 30).
Creating a Track Arming Profile

The Create Track Arming Profile dialog provides extensive control over Pro Tools track arming. You can customize arming, track naming, and mapping, and save configurations for different machines as Track Arming Profile files. These Profiles can be imported to quickly reconfigure Track Arming as needed for future projects. You can also test track mapping, and remap tracks if needed.

Use the Create Track Arming Profile feature to create profiles for machines that may not be included with Pro Tools, and to manage multiple profiles.

To create a machine Track Arming Profile:


Choosing a Machine ID

To recognize your machine:

- In the Create Machine Track Arming Profile dialog, click Identify Machine.

MachineControl queries the connected machine for its machine ID, which is then displayed below the Identify Machine button.

You can edit or replace the ID manually if needed. See “Entering a New Byte Code” on page 31 for more information.

Configuring a Profile

The Create Track Arming window lets you specify track names and track mapping.

Customizing Names for Track Arming Buttons

You can rename the Track Arm buttons displayed in each Track Arming Profile to better describes the recording taking place. For example, an eight track profile might be easier to use with tracks named Dx-L, Dx-R, FX-L, FX-R, Mx-L, Mx-R, Lt, and Rt, for eight tracks comprised of stereo Dialog, stereo FX, stereo Music, and an Lt-Rt mix.
To edit the name of a track arming button:

1. In the Create Machine Track Arming Profile dialog, double-click the Track Arm button you want to rename.
2. Enter a new track name in the dialog, and click OK.

Entering a custom track name

Remapping Tracks

You can remap track buttons to target different tracks on the machine.

To remap tracks:

1. In the Create Machine Track Arming Profile dialog, click the Track button you want to remap to display its remap pop-up menu.
2. Do one of the following:
   - Choose a new target track.
   - Choose a different machine profile from the Load Configuration selector.

Remapping a track arming button

Reassigning the Byte Value for a Track

In a remote machine’s firmware, each record track on the machine has a unique hexadecimal byte code that tells the machine which track should be armed when an arm command is received from a remote master. The standard profile (the default setup) corresponds to the Sony P-2 protocol, but many decks have their own unique mapping of byte codes to track numbers for a particular deck.

If an audio or video track, or the deck time code track do not arm when you click its corresponding track arming button, you may need to assign a different hex value to the button.

To select a different hex value for an individual track arm button:

- Select another hex value byte code from the Byte Code sub-menu for the appropriate track arm button.

Entering a New Byte Code

As the Sony P2 protocol continues to expand, more manufacturers add specific byte code commands that may be listed in the current byte code list. Pro Tools lets you create entirely new, custom byte codes. This lets you enter additional byte commands as needed to support new features as they are added to decks.

Entering a new byte code
Choosing a Record Protocol

The Machine Track Arming window provides the following two choices for configuring the recording protocol of the target deck:

**Auto Edit**

This mode is a highly accurate way to ensure that the target deck will record only within the boundaries of an on-screen selection. (If your deck does not support Auto Edit, use Punch In/Punch Out, as explained below.)

In Auto Edit mode, the record start/end times are downloaded to the target deck (along with any pre- or post-roll), and the deck is responsible for performing the insert punch in/out at the specified times (see “Rules for On-Screen Selections” on page 33 for details).

Because this protocol removes the vagaries of CPU timing from the remote recording process, Auto Edit is frame-accurate. It is also the best way to ensure that your machine will punch out correctly and avoid accidental erasure of audio, even in the event of a CPU error.

**Punch In/Out**

This mode uses Pro Tools to control the process of punch in/out. Instead of downloading the punch points (as in Auto Edit), Pro Tools actually performs them during the record pass. Because serial communication has inherent delays, timing with Punch In/Punch Out mode cannot guarantee frame-accuracy (though it will almost always be within 2 to 3 frames).

Choosing a Record Mode

The Machine Track Arming window provides two choices for Record mode:

**Insert**

Insert mode is used to perform insert editing (punching in individual tracks) where one or more audio tracks is replaced by new material and the video material is retained.

**Assemble**

Use Assemble mode when you want to:

- Begin recording program onto a completely blank tape (unformatted)
  - or -
- Append program to the remainder of a tape which already has program you want to keep

Assemble mode is not appropriate for audio laybacks to video masters.

Assemble mode should be used carefully because it arms all tracks on the target deck for recording—including the video track, time code track and control track. When performing an Assemble edit, all material on all tracks after the edit in point will be replaced. Because a break in the control track will result at the edit out point, any remaining program material after an Assemble edit may be unusable.

To avoid accidentally recording over program material, experiment with Assemble and Insert modes on a dispensable tape to familiarize yourself with the edit capabilities of your deck.

⚠️ **Assemble mode replaces all the elements on the target tape deck—audio, video and time code. Use this mode with caution.**
Rules for On-Screen Selections

The Record Protocol buttons allow you to choose between the two different record protocol choices described above (Auto Edit and Punch In/Punch Out). Regardless of which choice is used, however, Pro Tools follows these rules for record selection:

- If there is an on-screen selection, recording will take place over the period of the selection and punch out at the end of the selection.
- If pre- or post-roll is enabled, recording takes place only in the selection area, not during pre- or post-roll.
- If there is no selection (only a start location), recording will continue until it is manually stopped.
- If you make a selection in Pro Tools that crosses the “midnight” boundary (00:00:00:00), make sure your deck can handle this situation. Experiment with a dispensable tape to familiarize yourself with the crossover capabilities of your deck.

Rehearsing a Layback to an External Device

Before laying back audio to an external device, you can rehearse the layback using Edit Preview (Rehearse) mode. In Edit Preview mode, instead of performing an edit insert (recording) on armed remote tracks, the input is monitored without recording.

While in Edit Preview mode, the Transport Record button flashes yellow when armed and lights solid yellow when rehearsing. Armed tracks are indicated by yellow track buttons in the Track Arming window.

To rehearse a layback:

1. In Pro Tools, select the audio you want to rehearse for layback, or place the playback cursor at a start point.
2. Choose Window > Machine Track Arming.
3. In the Track Arming window, select Edit Preview.
4. In the Track Arming window, arm the tracks you want to rehearse by clicking the corresponding buttons. The buttons light yellow to indicate armed status.
5. In the Pro Tools Transport window, select Transport = Machine.
6. In the Pro Tools Transport window, click the Online button to put Pro Tools online.
7. In the Pro Tools Transport window, click Record. The button flashes yellow to indicate Edit Preview (Rehearse) mode.
8. In the Pro Tools Transport window, click Play.

The machine cues to the selection start or insert point and being playing back. Pro Tools then syncs to the deck, and the deck records as determined by the settings for Record Protocol and Record mode in the Track Arming window.
**Arming Tracks Remotely for Layback**

To arm tracks remotely for layback, you need to first configure Track Arming for your machine.

**To configure Track Arming:**

1. Make sure your machine is properly connected and configured to slave to Pro Tools.
2. Open the Track Arming window.
3. Select a Record Protocol (Auto Edit or Punch In/Out).
4. Select a Record mode (Insert or Assemble).

💡 *Once the Track Arming options are configured, you can change the Track Arming window to “small view” and still see the track arm buttons.*

**To perform a layback:**

1. In Pro Tools, select the audio to lay back, or place the playback cursor at a start point.
2. In the Remote Track Arming window, arm the appropriate tracks on the machine.
4. Make sure the Pro Tools Transport is online.
5. Click Record in the Transport window to arm recording.
6. Click Play in the Transport window.

Your machine will cue to the selection start minus all relevant pre-roll, then begin to play back. Pro Tools will then sync to the deck, and the target deck will record as determined by your settings for Record Protocol and Record mode. If you did not create an on-screen selection, deck recording will continue until you manually stop playback.
Remote 9-Pin Deck Emulation mode makes Pro Tools operate as a virtual tape deck, supporting most standard Sony P2 9-pin commands. For a list of supported commands, see “9-Pin Commands” on page 40.

By default, Pro Tools emulates a Sony BVW-75 model video deck. You can also configure Pro Tools to emulate other machines. For more information, see “Alternate Machine Types” on page 37.

For instructions on connecting Pro Tools for Remote 9-Pin Deck Emulation mode, see Chapter 2, “Installing MachineControl.”

### Generating Time Code in Remote 9-Pin Deck Emulation Mode

Pro Tools with MachineControl and a SYNC peripheral can generate frame-edge aligned time code at 1x play speed while in Remote 9-Pin Deck Emulation mode.

### Configuring Remote 9-Pin Deck Emulation Mode

To configure Pro Tools for Remote 9-Pin Deck Emulation mode:

1. Choose Setup > Peripherals, and click the Synchronization tab.
2. Choose SYNC from the Device pop-up menu.
3. Click the Machine Control tab in the Peripherals dialog.
4. In the 9-Pin Remote (Deck Emulation) section, select Enable.
5. Select the 9-pin MachineControl port from the Port pop-up menu.
6. Choose the appropriate machine profile from the Machine Type pop-up menu.
7. If you want Pro Tools to ignore transport commands and just chase LTC, enable Chase LTC.
8 Click OK to close the Peripherals dialog.

9 In the Transport window, click the Remote button to put Pro Tools in Remote mode.

![Remote button in Transport window](image)

10 Choose Setup > Session, and ensure that the following settings are configured:

- The Clock Source should be set to SYNC.
- The Clock Reference should be set to Video Reference.
- If you did not enable Chase LTC, the Positional Reference should be set to Generate. This is required for Pro Tools to lock to the video reference with frame edge accuracy.
- If you enabled Chase LTC, the Positional Reference should be set to LTC.

11 If you will be recording, select a Record mode by right-clicking (Windows or Mac) or Control-clicking (Mac) the Record button in the Transport window.

12 Begin machine playback.

*See also “Optimizing Playback in Remote 9-Pin Deck Emulation Mode” on page 39.*

---

**Selecting Full Remote Mode or Remote/LTC Chase Mode**

Remote 9-Pin Deck Emulation mode lets a master device control Pro Tools track and transport arming.

- When Pro Tools is in Remote mode, Remote 9-pin Deck Emulation operates in Full Remote mode or in Remote/LTC Chase mode.
- When Pro Tools is not in Remote mode, it ignores commands from the 9-pin machine controller. Pro Tools responds only to requests from the 9-pin machine controller for machine type and status, and responds that it is in Local mode.

**Full Remote Mode**

In Remote 9-Pin Deck Emulation mode, when Pro Tools is in Remote mode and Chase LTC is not enabled, Pro Tools is in one of the two following states:

- When the Delay after Play Command preference is set to zero, Pro Tools is set to function as the time code master. Pro Tools locates, then plays when it gets a play command.
- When the Delay after Play Command preference is set towards 30 frames, another machine is the time code master. Pro Tools locates, sends time code position responses, and when its time code lines up with the time code master device, goes into play in sync with the time code master device.
To set the time code master in Full Remote mode:

1. Choose Setup > Preferences, and click the Synchronization tab.

2. In the Remote Mode section, do one of the following:
   - Set the Delay after Play Command preference to zero, to set Pro Tools to behave as the time code master.
   - Set the Delay after Play Command preference towards 30 frames, to set Pro Tools to behave as a time code slave device, by delaying playback until its time code can properly synchronize.

Generally, delay should only be added if Pro Tools is having problems starting and locking to a machine during playback or record. For example, if Pro Tools tries to lock, and the Transport window lights go from play to shuttle or fast-forward to rewind many times before locking, you should increase the Delay After Play setting by a few frames.

Remote/LTC Chase Mode

When Chase LTC is enabled, Pro Tools can still respond to track arming and record commands. However, Pro Tools will chase incoming LTC instead of behaving as a master or slave device with the machine controller. By slaving Pro Tools to the LTC source instead of slaving the machine to Pro Tools time code, you can avoid the waiting (and tape wear) that occurs while a machine transport locates and bumps tape to the cue point.

In Remote 9-Pin Deck Emulation mode, when Pro Tools is in Remote Mode and Chase LTC is enabled, it communicates record status to the machine.

Receiving Commands While Chase LTC is Enabled or Disabled

- When Chase LTC is enabled, Pro Tools waits until it receives only specific transport record and track record commands from the machine.
- When Chase LTC is not enabled, Pro Tools listens to all transport commands coming through the serial connection, including bump and crawl commands necessary for a tape machine to locate.

Scrubbing and Chase LTC

The Chase LTC option does not affect scrubbing. Pro Tools video playback will always respond to locate and scrubbing command, even if Chase LTC is enabled.

Alternate Machine Types

By default, MachineControl lets Pro Tools emulate a Sony BVW-75. If you use a machine that follows a different 9-pin command set, you can configure Pro Tools for that machine’s description.

To configure Pro Tools for an alternate machine:

1. Choose Setup > Peripherals, and click the Machine Control tab.

2. In the 9-Pin Remote (Deck Emulation) section, choose a machine profile from the Machine Type pop-up menu.

3. Click OK.

Special settings have been created for specific machine controllers (such as the Soundmaster ION). When under the control of a specific machine controller, first check if there is a specific setting for that machine controller.
Preferences for Remote 9-Pin Deck Emulation Mode

Pro Tools provides the following preference settings to configure Remote 9-Pin Deck Emulation Mode options.

Remote Mode Section

Ignore Track Arming Sets Pro Tools to ignore incoming track arming (record enable) commands. This is useful if you are using a master controller to arm tracks on other machines, but you do not want to arm tracks in Pro Tools.

Set Servo Lock Bit At Play (Tamura Support) Enable this option when using a Tamura synchronizer to control Pro Tools in Remote mode to minimize lock-up times during recording.

Allow Track Arm Commands in Local Mode Enables a supported third-party paddle device to issue the following Pro Tools track commands while in Local mode:

- Input monitoring
- Record Enable
- Record Safe
- Solo
- Solo Mute

Delay After Play Command Sets the amount of time (in frames) for Pro Tools to wait after receiving a Play command before starting the audio engine. This can prevent false starts when locking to synchronizers that are not fully supported by Pro Tools.

To set Remote 9-Pin Deck Emulation mode preferences:

1. Choose Setup > Preferences, and click the Synchronization tab.
2. Select or set Machine Control options in the Remote mode section:
3. Click OK to close the Preferences dialog.

See “Selecting Full Remote Mode or Remote/LTC Chase Mode” on page 36 for more information.

Punch In Frame Offset Sets an offset in frames to compensate for punch-in timing advances or delays.

Punch Out Frame Offset Sets an offset in frames to compensate for punch-out timing advances or delays.

See Chapter 7, “Using a Paddle Device in Local Mode.”
**Playback in Remote 9-Pin Deck Emulation Mode**

Pro Tools plays back audio only when the received command requires audio playback at 1X speed in the forward direction. Reverse playback and varispeed playback are not supported in Pro Tools.

**Optimizing Playback in Remote 9-Pin Deck Emulation Mode**

When using Remote 9-Pin Deck Emulation mode with an unsupported synchronizer, clicking Play may display multiple nudge and bump messages caused by Pro Tools attempting to achieve lock before the master device has stabilized.

The Delay After Play Command preference lets you configure a short delay before Pro Tools attempts to lock with the master device. This allows the master device to stabilize before Pro Tools locks with it in order to avoid nudge and bump messages.

See “Preferences for Remote 9-Pin Deck Emulation Mode” on page 38 for more information.

**Recording in Remote 9-Pin Deck Emulation Mode**

MachineControl lets Pro Tools support Auto Edit (selection-based) and Punch-in/Punch-Out (QuickPunch) commands.

Pro Tools must have QuickPunch or TrackPunch with tracks enabled when recording in Remote 9-Pin Deck Emulation mode with an edit controller.

⚠️ *Preview Edit and Rehearse modes are not supported by Pro Tools.*

**Auto Edit Recording**

When a machine sends Auto Edit commands to Pro Tools in Remote 9-Pin Deck Emulation mode, the edit in and out points are converted to a Pro Tools Timeline selection. This selection, with offsets options, will then be used to record on all armed tracks when Pro Tools receives the Perform Auto Edit Record command.

**Punch In/Out Recording**

Punch-In/Punch-Out Recording supports punch-on-the-fly, with Pro Tools in QuickPunch mode. In this mode, tracks are armed before the record pass, and recording begins and ends when Punch-In and Punch-Out commands are received from the master machine.

QuickPunch must be enabled and the required voices must be available in Pro Tools for Punch-In/Punch-Out recording commands to work. This mode must be set manually in Pro Tools.
Track Arming in Remote 9-Pin Deck Emulation Mode

In Remote 9-Pin Deck Emulation mode, Pro Tools can be configured to either respond to, or ignore, track arming (record enabling) commands. Pro Tools communicates track record status back to the control machine.

9-Pin Commands

In Remote 9-Pin Deck Emulation Mode, Pro Tools with MachineControl can respond to the following 9-pin commands from compatible workstations, synchronizers, and other devices:

- Play
- Stop
- Pause
- Rewind
- Forward
- Cue To
- Poll Time Code
- Record Arm Track
- Set In/Out Point (for Auto Edit)
- Set Pre/Post Roll (for Auto Edit)
- Perform Auto Edit Record
- Perform Punch-In/Punch-Out Record (requires QuickPunch mode and voices)
- Return Status-Online, State, Tracks Armed
- Servo Lock
- Clear “In” Point

Ignore Track Arming Commands

You can set Pro Tools to ignore incoming track arming (record-enable) commands. Use this to record-safe Pro Tools if, for example, you are using a master 9-pin transport controller to arm tracks on several other machines, but not Pro Tools tracks. You can still manually arm Pro Tools audio tracks, as needed.

To have Pro Tools ignore remote track arming commands:

1. Choose Setup > Preferences, and click the Synchronization tab.
2. In the Remote Mode section, select Ignore Track Arming.
When using MachineControl in Local mode (with or without an external synchronizer), you can use a supported third-party paddle device to issue the following Pro Tools track commands:

- Input monitoring
- Record Enable
- Record Safe
- Solo
- Solo Mute

Using these features involve the following steps:

1. Connect the supported third-party paddle device to your system.
2. Make sure the Allow Track Arm Commands in Local Mode preference is enabled.
3. Serial Deck Control and Remote 9-Pin Deck Emulation ports must be configured simultaneously.

---

**Connecting a Supported Third-Party Paddle Device to Your Pro Tools System**

To connect a supported third-party paddle device to your Pro Tools system, use the same method you would use to connect a deck for Remote 9-Pin Deck Emulation mode.

*See Chapter 6, “Remote 9-Pin Deck Emulation Mode (Configuration and Operation)” for detailed information on connecting a machine to Pro Tools.*
Allow Track Arm Commands in Local Mode Preference

The Allow Track Arm Commands in Local Mode preference must be enabled in order to control Pro Tools with a paddle device in Local mode.

To enable the Allow Track Arm Commands in Local Mode preference:

1. Choose Setup > Preferences, and click the Synchronization tab.
2. Select Allow Track Arm Commands in Local Mode.

Configuring Ports for a Deck and a Supported Third-Party Paddle Device

Before connecting a paddle device and a deck to Pro Tools simultaneously, both the Serial Deck Control port and the Remote 9-Pin Deck Emulation port may be configured.

To configure Serial Deck Control and Remote 9-Pin Deck Emulation ports to operate simultaneously:

3. Choose Setup > Peripherals, and click the Synchronization tab.
4. Choose SYNC from the Device pop-up menu.
5. Click the Machine Control tab.
6. In the 9-pin Machine Control (Deck Control) section, select Enable.
7. Select the 9-pin MachineControl port from the Port pop-up menu.
8. Choose the appropriate machine profile from the Machine Type pop-up menu.

See Chapter 5, “Serial Deck Control Mode (Configuration and Operation)” for detailed information about configuring and using Serial Deck Control mode.

9. In the 9-Pin Remote (Deck Emulation) section, select Enable.

Remote 9-Pin Deck Emulation mode settings

10. Select the 9-pin MachineControl port from the Port pop-up menu.
11. Choose the appropriate machine profile from the Machine Type pop-up menu.
12. Make sure Chase LTC is not selected.
13. Click OK to close the Peripherals dialog.

To set Pro Tools to Local mode:

- In the Pro Tools Transport window, make sure that the setting is Transport = Pro Tools.

Setting Transport = Pro Tools
# Appendix A: Deck Control Key Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Mac</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rewind</td>
<td>Shift+&lt;</td>
<td>Shift+&lt;</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>Shift+&gt;</td>
<td>Shift+&gt;</td>
</tr>
<tr>
<td>Shuttle Backward</td>
<td>Option+comma</td>
<td>Start+comma</td>
</tr>
<tr>
<td>Shuttle Forward</td>
<td>Option+period</td>
<td>Start+period</td>
</tr>
<tr>
<td>Toggle Transport Master</td>
<td>Command+\</td>
<td>Control+\</td>
</tr>
<tr>
<td>All Transport Buttons Off/Unthread Tape</td>
<td>Command+period</td>
<td>Control+period</td>
</tr>
<tr>
<td>Search Mode Toggle (Play-Pause/Stop)</td>
<td>Spacebar/Command+period</td>
<td>Spacebar/Ctrl+period</td>
</tr>
</tbody>
</table>

**When Transport = Machine:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Mac</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cue to Selection Start</td>
<td>Command+Left Arrow</td>
<td>Control+Left Arrow</td>
</tr>
<tr>
<td>Cue to Selection End</td>
<td>Command+Right Arrow</td>
<td>Control+Right Arrow</td>
</tr>
<tr>
<td>Cue to Selection Start Minus Preroll</td>
<td>Option+Left Arrow</td>
<td>Alt+Left Arrow</td>
</tr>
<tr>
<td>Cue to Selection End Minus Preroll</td>
<td>Option+Right Arrow</td>
<td>Alt+Right Arrow</td>
</tr>
</tbody>
</table>
Installation

Problem:
MachineControl options are not available in Pro Tools.

Possible Solution:
Make sure MachineControl is installed and authorized correctly (see Chapter 2, “Installing MachineControl.”)

Machine Not Recognized

Problem:
The session was saved with MachineControl, but now opens without it being selected in the Transport window. When opening a session saved with MachineControl, a dialog warns that there were “problems initializing MachineControl.” When spotting a region, the “Capture Machine Time” button is grayed out.

Possible Solutions:
- Choose Setup > Peripherals, click the Machine Control tab, and confirm that the correct 9-Pin Serial port is chosen for your MachineControl operating mode. Make certain that all cables are securely connected at both ends.
- Verify that the machine is powered on. Choose Setup > Peripherals, and click the Machine Control tab. Reset the 9-Pin Serial port, and close the dialog. This causes Pro Tools to scan the serial port for 9-pin devices.

Pro Tools Transport Not Controlling Machine

Problem:
Though the MachineControl dialog indicates that Pro Tools recognizes the machine, nothing happens when you use the Transport in Pro Tools (the machine doesn’t respond to commands). When spotting a region using the “Capture Machine Time” button, an incorrect time is entered.
Possible Solutions:

- Most controllable transports need to be placed in a “Remote” or “Ext” mode to allow them to be slaved to other devices. Verify that the device is in this mode. Refer to the documentation that came with your device for more information on Remote and Local modes.
- In the Transport window, check the status of the “Transport = Pro Tools” or “Transport = Machine” setting.

Time Code Inaccuracy

Problem:

The time code locations shown in the Selection and Position Indicator boxes do not match machine time code.

Possible Solutions:

- For best performance with Serial Deck Control mode, connect the machine to an available serial or COM port (or serial adapter connected to a USB port) on the host computer. Use the 9-pin ports on a SYNC peripheral for non-linear video decks only.
- In some cases, the Time Code values reported by machines are not in sync with the time code that is played from their time code ports. (One example of this is when the machine's time code reader is looking at VITC while Pro Tools is chasing LTC.)
- If the values get progressively farther and farther apart, check the frame rate. Make sure you have set Pro Tools to the same frame rate as the movie/machine frame rate. Also check the frame format (drop or non-drop).
- If the values differ by a significant margin (such as an hour or more), the Start Frame number may be set incorrectly. Open the Session Setup window and check the Session Start Frame number.

Changing Session Start Time, Dropped Frames, and Drop Frame Time Code

When you change the session frame rate from a non-drop to drop rate, or from drop to non-drop, the session start time and material in the Timeline may be affected.

Non-drop Changed to Drop: The Session Start Time is changed to the next possible supported frame if the current one is not supported in DF. For example, changing from non-drop to drop frame in a session that starts at 00:59:00:00 will change the session’s start time to 00:59:00:02 (due to the method by which frames are dropped in each rate and format).

Every event in the Timeline is moved back two frames, maintaining each event’s relative time code location (relative to the start of the session).

Drop Changed to Non-drop: When going from drop to non-drop, no compensation is applied to the session start time. This is done because all frames in drop exist in a non-drop Timeline (a drop rate Timeline is a subset of its corresponding non-drop rate Timeline). So, when changing from a drop rate to a non-drop rate, Pro Tools keeps events at the same location relative to the start of the session.
Appendix C

Machine IDs

The following table lists the machine profiles supported in MachineControl by their Pro Tools hexadecimal ID.

For special IDs to support 48-track arming, see “48 Track Profiles” on page 48.

**Machines and Hex ID Numbers**

The first 0x signifies hex value. The next four numbers signify the machine ID. The name of the associated machine follows.

<table>
<thead>
<tr>
<th>ID number</th>
<th>Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0000</td>
<td>Generic 1</td>
</tr>
<tr>
<td>0x0001</td>
<td>Generic 2</td>
</tr>
<tr>
<td>0x1000</td>
<td>BVU-800</td>
</tr>
<tr>
<td>0x101C</td>
<td>BVU-950</td>
</tr>
<tr>
<td>0x1019</td>
<td>BVU-920</td>
</tr>
<tr>
<td>0x1080</td>
<td>BVU-900</td>
</tr>
<tr>
<td>0x104C</td>
<td>VO-9850</td>
</tr>
<tr>
<td>0x1048</td>
<td>VO-9800</td>
</tr>
<tr>
<td>0x102C</td>
<td>SVO-9600</td>
</tr>
<tr>
<td>0x1000</td>
<td>BVW-10</td>
</tr>
<tr>
<td>0x1001</td>
<td>BVW-40</td>
</tr>
<tr>
<td>0x1002</td>
<td>BVW-11</td>
</tr>
<tr>
<td>0x1003</td>
<td>BVW-15</td>
</tr>
<tr>
<td>0x1010</td>
<td>BVW-35</td>
</tr>
<tr>
<td>0x2020</td>
<td>BVW-60</td>
</tr>
<tr>
<td>0x2021</td>
<td>BVW-65</td>
</tr>
<tr>
<td>0x2022</td>
<td>BVW-95</td>
</tr>
<tr>
<td>0x2023</td>
<td>BVW-96</td>
</tr>
<tr>
<td>0x2024</td>
<td>BVW-70</td>
</tr>
<tr>
<td>0x2025</td>
<td>BVW-75</td>
</tr>
<tr>
<td>0x2125</td>
<td>BVW-75P</td>
</tr>
<tr>
<td>0x4000</td>
<td>DVR-10</td>
</tr>
<tr>
<td>0x4003</td>
<td>DVR-18</td>
</tr>
<tr>
<td>0x4002</td>
<td>DVRC-10</td>
</tr>
<tr>
<td>0x4020</td>
<td>DVR-20</td>
</tr>
<tr>
<td>0x4022</td>
<td>DVR-28</td>
</tr>
<tr>
<td>0xF019</td>
<td>AJ-D350 (D3)</td>
</tr>
<tr>
<td>0x3011</td>
<td>DVR-2100</td>
</tr>
<tr>
<td>0x3000</td>
<td>DVR-1000</td>
</tr>
<tr>
<td>0x0010</td>
<td>BVH-2000</td>
</tr>
<tr>
<td>0x0011</td>
<td>BVH-2000</td>
</tr>
<tr>
<td>0x0110</td>
<td>BVH-2000 PS</td>
</tr>
<tr>
<td>0x0111</td>
<td>BVH-2000 PS</td>
</tr>
<tr>
<td>0x0018</td>
<td>BVH-2180</td>
</tr>
<tr>
<td>0x0020</td>
<td>BVH-2500</td>
</tr>
<tr>
<td>0x0120</td>
<td>BVH-2500 PS (UI wrong)</td>
</tr>
<tr>
<td>0x0030</td>
<td>BVH-2700</td>
</tr>
</tbody>
</table>
The following are special IDs to support 48-track arming.

### Machines, by ID number

<table>
<thead>
<tr>
<th>ID number</th>
<th>Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0040</td>
<td>BVH-2800</td>
</tr>
<tr>
<td>0x0048</td>
<td>BVH-2830</td>
</tr>
<tr>
<td>0x0050</td>
<td>BVH-3000</td>
</tr>
<tr>
<td>0x0060</td>
<td>BVH-3100</td>
</tr>
<tr>
<td>0x0150</td>
<td>BVH-3000 PS</td>
</tr>
<tr>
<td>0x0160</td>
<td>BVH-3100 PS</td>
</tr>
<tr>
<td>0x2041</td>
<td>PVW-2800</td>
</tr>
<tr>
<td>0x1211</td>
<td>ASC Virtual Recorder</td>
</tr>
<tr>
<td>0x1011</td>
<td>Fostex D-10</td>
</tr>
<tr>
<td>0xF027</td>
<td>Otari R-DAT</td>
</tr>
<tr>
<td>0x7001</td>
<td>PCM-7030</td>
</tr>
<tr>
<td>0x7001</td>
<td>TASCAM DA-88</td>
</tr>
<tr>
<td>0x7003</td>
<td>PCM-800</td>
</tr>
<tr>
<td>0x7000</td>
<td>PCM-7000</td>
</tr>
<tr>
<td>0xA088</td>
<td>AG-DS555</td>
</tr>
<tr>
<td>0xA084</td>
<td>AG-DS770</td>
</tr>
<tr>
<td>0x0001</td>
<td>AG-DS7750</td>
</tr>
<tr>
<td>0xF033</td>
<td>AJ D640</td>
</tr>
<tr>
<td>0x2051</td>
<td>UVW-1800</td>
</tr>
<tr>
<td>0xB000</td>
<td>DVW-500</td>
</tr>
<tr>
<td>0xB010</td>
<td>DVW-500</td>
</tr>
<tr>
<td>0xA050</td>
<td>V1</td>
</tr>
<tr>
<td>0x1021</td>
<td>SVP-5600</td>
</tr>
<tr>
<td>0x2124</td>
<td>BCB-70</td>
</tr>
<tr>
<td>0x2101</td>
<td>BVW-40P</td>
</tr>
<tr>
<td>0x8017</td>
<td>DSR-1500A</td>
</tr>
<tr>
<td>0x6007</td>
<td>3348HR</td>
</tr>
<tr>
<td>0x6005</td>
<td>3348HRV</td>
</tr>
<tr>
<td>0x6003</td>
<td>3324</td>
</tr>
</tbody>
</table>

Tascam DA-88 and other decks can be set to emulate other machines. If a deck is set to emulate another type of machine, the machine type being emulated will be displayed.

### 48 Track Profiles

The following are special IDs to support 48-track arming.

#### Machines

**IDs for 48-Track Capable Machines**

<table>
<thead>
<tr>
<th>ID</th>
<th>Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x6007</td>
<td>3348HR</td>
</tr>
<tr>
<td>0x6005</td>
<td>3348HRV</td>
</tr>
<tr>
<td>0x6003</td>
<td>3324</td>
</tr>
</tbody>
</table>

**Pro Tools**

**IDs for 48-Track Pro Tools Arming**

<table>
<thead>
<tr>
<th>ID</th>
<th>Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX01</td>
<td>Pro Tools</td>
</tr>
</tbody>
</table>
Appendix D: 9-Pin Cable Pinouts

Serial Deck Control Mode Cable:
D Sub 9-Pin Male to D Sub 9-Pin Female (Windows Only)

Cable Construction Details
Machine Control Cable
For Controlling a 9-Pin RS-422
Tape Transport from a standard
Windows PC serial port

Windows PC Side
9-Pin Female
DB-9F Connector
to mate with 9-pin
male on PC chassis

Controlled Deck Side
9-Pin Male
DB-9M Connector
to mate with 9-pin
female on Deck

PC Side
Pin Assignments on DB-9F Connector
1 - DCD (Input; Data Carrier Detect)
2 - RxD (Input; Receive Data)
3 - TxD (Output; Transmit Data)
4 - DTR (Output; Data Terminal Ready)
5 - SG (Signal Ground)
6 - DSR (Input; Data Set Ready)
7 - RTS (Output; Request to Send)
8 - CTS (Input; Clear to Send)
9 - RI (Input; Ring Indicator) (No Connect)

Deck Side
Pin Assignments on DB-9M Connector
1 - No Connection
2 - Output; TxD (-)
3 - Input; RxD (+)
4 - Shield for Input Twisted Pair on Pins 3 & 8
5 - No Connection
6 - Shield for Output Twisted Pair on Pins 2 & 7
7 - Output; TxD (+) (No Connection)
8 - Input; RxD (-)
9 - No Connection
MachineControl Master/Slave Adapter
Serial Deck Control Cable:  
Mini DIN 8 Male to D Sub 9-Pin Male (Mac Only)

<table>
<thead>
<tr>
<th>Mini - 8</th>
<th>DB-9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC</td>
</tr>
<tr>
<td>2</td>
<td>NC</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
</tr>
<tr>
<td>7</td>
<td>NC</td>
</tr>
<tr>
<td>8</td>
<td>7</td>
</tr>
<tr>
<td>Shield</td>
<td>NC Shield</td>
</tr>
</tbody>
</table>
Remote 9-Pin Deck Emulation Cable:  
Mini DIN 8-Pin to D Sub 9-Pin Female (Mac Only)

<table>
<thead>
<tr>
<th>Remote 9-Pin Deck Emulation Mode Cable (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB-9</td>
</tr>
<tr>
<td>NC</td>
</tr>
<tr>
<td>NC</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>G,1</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>NC</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>NC Shield</td>
</tr>
</tbody>
</table>

**Shielding**

The outside shielding of the D-Sub 9-pin (female) should be wired to the outside shielding of the Mini DIN 8-pin (male).
# Index

**A**
- Allow Track Arm Commands in Local Mode option 42
- arming  
  - safe (ignore) 40
- Assemble mode 32
- authorizing MachineControl 8, 9
- Auto Edit 32, 39
- Auto Spot 14, 26, 28

**C**
- cables  
  - included cables 1  
  - wiring diagrams 51, 52
- Chase LTC mode 37
- configuring a paddle device 42
- control track 32
- Create Machine Track Arming Profile 30
- cueing  
  - hi-speed mode 28
  - search mode 28

**D**
- Delay After Play Command option 38
- Delay Before Locking to LTC option 20
- Delay Before Locking to Time Code option 20

**E**
- External Time Code Offsets 24

**H**
- hi-speed mode 28

**I**
- IDs (machine) 47
- Ignore Track Arming option 38, 40
- iLok USB Smart Key 8
- Incoming Time 24
- Insert mode 32
- installing MachineControl 8

**L**
- layback 34
- Local/Remote 27

**M**
- machine  
  - pre-roll 18
  - profiles 30, 47
  - Transport Master 14, 26
- Machine Chases Memory Location option 20
- Machine Cues Intelligently option 20
- Machine Follows Edit Insertion/Scrub option 20
- machine IDs 47
- midnight boundary 33
- Minimum Sync Delay option 20

**N**
- Non-Linear Transport Error Suppression option 20

**O**
- Online (Transport window) 13
- Online options 21
- On-Screen Selections 33
P
paddle device 42
configuring ports for 42
connecting to a Pro Tools system 41
preferences
Remote mode 38
pre-roll
compensating 18
machine 18
setting for machine from Pro Tools 18
Pro Tools
Transport Master 14, 26
Punch In Frame Offset 38
Punch In/Out 32
Punch Out Frame Offset 38

R
record modes 32
Record Online at Insertion/Selection option 21
Record Online at Time Code (or ADAT) Lock option 21
record protocol 32
Auto Edit 32
Punch In/Out 32
recording
Remote mode 39
Redefine Current Time Code Position 25
Remote 9-Pin Deck Emulation mode 10
Chase LTC 37
connections 7
preferences 38
see also Remote mode
Remote LTC mode
Transport Master 16, 36, 37
Remote mode
and track arming 40
Auto Edit 39
commands 40
playback 39
recording 39
Transport Master 16, 36, 37

S
Sample Offset (Sync Offset) 24
search mode 28
Serial Deck Control mode 10
serial time code 19
servo lock 18
start time 23
Stop at Shuttle Speed Zero option 20
Sync Offset 24
system requirements 2

T
time code
quick signal test 24
redefine current 25
track 32
track arming
48-track IDs 48
and Remote mode 40
create machine profile 30
IDs 47
ignore 40
remapping tracks 31
tracks
remapping 31
Transport Master 11, 14, 27
machine 14, 26
Pro Tools 14, 26
Remote 16, 36, 37
Remote LTC 16, 37
selecting 13
toggling 14
transport master 26
Remote LTC 36
toggling 27
Trimmer
when Transport = Machine 14, 26

V
video track 32